Read Me

Pro Tools 11.0.2 on Windows 7 and Windows 8, and
Pro Tools HD 11.0.2 on Windows 7
This Read Me documents important compatibility information, resolved and known issues for the following software with supported
hardware on qualified computers:
• Pro Tools® 11.0.2 software running on Windows 7 (64-bit) or Windows 8 (64-bit)
• Pro Tools HD® 11.0.2 software (Windows 7 64-bit only)

Issues Resolved in Pro Tools 11.0.2
User-Reported Issues
If Pro Tools 11 quits unexpectedly, it automatically creates a Crash Log report that you can submit to Avid. By submitting the report,
you can help us identify and address the issue. In the Comments section of the dialog that appears, describe the nature of the session you
were working on and the action or command that you were carrying out just before the issue occurred, then click “Send to Avid.” The
issues below were identified and addressed using these reports.
Pro Tools no longer quits unexpectedly when trying to modify the ALL Group. (PTSW-184989)
Pro Tools no longer quits unexpectedly when a VCA window is open and Preferences dialog is opened and closed.
(PTSW-185798)
Eleven Rack rigs can now be loaded from Pro Tools. (PTSW-185410, PTSW-184975, PTSW-184982)
Pro Tools no longer quits unexpectedly while AudioSuite previewing with the Shift parameter adjusted to edge values.
(PTSW-185758)
Pro Tools no longer quits unexpectedly when playing a surround track with dense automation. (PTSW-185399)
Pro Tools no longer quits unexpectedly during offline bounce when a plug-in exists on an unvoiced track. (PTSW-185425)
Pro Tools no longer quits unexpectedly during offline bounce when signal routes back through the same mixer. (PTSW-185482)
Pro Tools no longer quits unexpectedly when indexing particular SDII files. (PTSW-185452)
Pro Tools no longer quits unexpectedly while re-linking missing audio files. (PTSW-185111)
Fixed infinite loop of error dialog “IO channel count for current playback device has changed. Please restart Pro Tools” when
RME HDSPe MADI FX is the declared Playback Engine. (PTSW-185010)
Pro Tools no longer quits unexpectedly while searching in Help after connecting to SoundCloud. (PTSW-185014)
Pro Tools no longer quits unexpectedly when pressing Alt-Tab while Pro Tools is launching . (PTSW-185602)
Pro Tools no longer quits unexpectedly when using the Shift key if a J.L. Cooper Surround Panner is declared in the Peripherals
dialog. (PTSW-184844)
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Recording
Audio recorded to tracks to the right of playback tracks is properly placed on the timeline. (PTSW-185778)
Destructive Punch records properly when the previous record pass extended past the end of the prepared audio.
(PTSW-177550)
Destructive Punch recording can be stopped in all situations. (PTSW-185339)
When recording to a track with an output assigned to a sub-stem of a main stem and with no tracks are assigned to the main
stem, Delay Compensation errors no longer occur. (PTSW-186092)
The RME Fireface can now be used as an ASIO device. (PTSW-186528)

Editing
Performance is improved when using the Automation “Write to End” command across many tracks. (PTSW-186229)
When the Session Start Time is not 00:00:00:00, spotting a file to a new track after an offline bounce now works properly.
(PTSW-185380)
User Time Stamp values are now entered correctly in the Clip List. (PTSW-186373)

Mixing
On Pro Tools|HDX systems, post-fader sends following a Native plug-in no longer consume an extra voice. (PTSW-184939)
Sends now work correctly with Preview mode. (PTSW-186227)

Plug-Ins
The Time Compression/Expansion AAX plug-in is included with Pro Tools 11.0.2.
D-Verb DSP AAX controls have been fixed. (PTSW-186175)

Video
Correct frames are now pasted to a track when the copied movie's true frame rate is less than the Video Project Type.
(PTSW-184987)
Enabling and disabling video hardware during scrub now work properly with third-party video hardware. (UME-856)
Black Magic hardware now locates correctly after stop if Insertion Follows Playback is disabled. (UME-867)
Video track settings are now available after reopening a session with video. (PTSW-184691)
Videos no longer incorrectly play back at double speed. (UME-819)
The Avid Video Engine no longer encounters video synchronization errors when playing beyond the 12-hour mark on the
timeline. (UME-906)
Video playback in Pro Tools no longer shows color deviation from playback in QuickTime player. (UME-823)

Workspace
The Workspace “Copy & Relink” function now works correctly. (PTSW-185803)
In the Workspace, Alt -revealing a folder exposes or hides all nested subfolders. (PTSW-182561)
The “T” label (for Transfer volumes) now appears correctly when changing permissions in the Workspace. (PTSW-185355)
Pro Tools no longer stops working when dragging files from the Workspace with Tempo Match enabled. (PTSW-185442)
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Bounce to Disk
MIDI events now play in order during an offline bounce. (PTSW-185058)
Offline bounce with automation is now phase-accurate when compared to a bussed re-record. (PTSW-179224)

Issues Resolved in Pro Tools 11.0.1
The ReVibe II plug-in is now available with support for Pro Tools 11.0.1 (and higher) and Pro Tools 10.3.6 (PTSW-184681,
PTSW-183157)
Pro Tools now receives MIDI input on Windows 8 when logged in with a non-administrator account (PTSW-184618)
Touching a VCA Master while in automation write or latch no longer causes all members of the group to become audible (when
volumes are set to –INF dB). Also, signal is no longer incorrectly sent to the VCA tracks’ corresponding sends (PTSW-184983)
When using ASIO applications with the Avid ASIO Driver with HDX or HD Native hardware, audio will not distort (PTSW-184721)
With the JL Cooper Surround Panner declared, Pro Tools will not quit unexpectedly when using the Shift Key for various
commands (PTSW-184844)

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.
For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the
Avid website (www.avid.com/compatibility).

iLok USB Smart Key (2nd Generation) and Pro Tools Authorization
An iLok (2nd Generation) must be connected at all times while running Pro Tools

Pro Tools requires that an iLok (2nd Generation) with the appropriate authorizations be connected to the computer at all times. Do not
remove the iLok while running Pro Tools 10.x. If the iLok is removed while Pro Tools is running, one of the following will occur:
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
• Click Quit. Pro Tools closes the session without saving and then quits.
– or –
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click OK to continue working in Pro Tools.
• Click Cancel. Pro Tools closes the session without saving and then quits.
Pro Tools does not recognize iLok connected to USB3 ports (PTSW-158204)

Texas Instruments USB3 controllers are currently incompatible with iLok generation 1 & 2 USB dongles. iLok dongles connected to a
Texas Instruments USB3 controller will not be recognized by Pro Tools or the iLok.com web site. Connect any iLok dongles to USB2
ports instead.

Installing Pro Tools 11 plug-ins
The Pro Tools Installer no longer updates purchased plug-ins. Download these installers separately.

If you have purchased any Avid plug-ins, you must download the related installers from your Products page at account.avid.com. The
Pro Tools installer still contains all bundled Avid plug-ins, such as Channel Strip and D-Verb.
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Co-Installing Pro Tools 10 and Pro Tools 11
Pro Tools 10.3.6 is the first version of Pro Tools 10 that supports installation on the same system with Pro Tools 11.
Co-installation is not yet supported for Windows 8.

If you have an earlier version of Pro Tools installed, it is recommended that you perform a clean uninstall before installing Pro Tools
10.3.6 and Pro Tools 11.

General Compatibility
Pro Tools 11 does not support video capture (PTSW-181456)

Pro Tools 11 does not have the ability to record video to the timeline. Co-install Pro Tools 10.3.6 (or higher) on the same system and
use an Avid Mojo SDI to record video into Pro Tools 10. The captured video can then be used in Pro Tools 11.
OMF files that contain video are not compatible with Pro Tools 11 (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 11. OMF sequences that contain embedded or referenced audio
files can be imported into Pro Tools 11. To import a sequence that contains video media, use a linked AAF sequence.
Pro Tools 11 cannot import WMA files (PTSW-181506)

If you attempt to import a WMA file into a Pro Tools 11 session, Pro Tools cannot convert the file and posts a “file is unreadable” message. Co-install Pro Tools 10.3.6 (or higher) on the same system, import the WMA file, and convert it to a format supported by
Pro Tools 11.
Legacy Pro Tools session file formats version 4.x and lower are not supported in Pro Tools 11 and higher (PTSW-181049)

Pro Tools session files from Pro Tools versions 4.x and lower are not recognized in Pro Tools 11 and higher. In the Pro Tools Workspace, these files are listed as “unknown,” and cannot be opened. Co-install Pro Tools 10.3.6 (or higher) on the same system and open
the session files in Pro Tools 10. Save the session in the current Pro Tools session format, then open the session in Pro Tools 11.
Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active Internet connection when behind a proxy server that requires authentication to gain Internet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy or the proxy needs
to allow HTTP access via port 80 without requiring authentication.
Aero causes errors at lower HW Buffer sizes (103563)

With Aero enabled in Windows, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn off Aero if you
want to use lower HW Buffer sizes.

Eleven Rack
Eleven Rack Guitar Window not available in Pro Tools 11 (PTSW-184398)

Pro Tools 11 does not provide the Guitar Window for Eleven Rack that is available in lower versions of Pro Tools.

VENUE
VENUE systems with two HDx Option cards may not be recognized by Pro Tools|HD Native systems (PTSW-142834)

If a second HDx Option card is installed in a VENUE system, it may cause both HDx cards not to be recognized by Pro Tools|HD Native
systems. A single VENUE HDx Option card is recognized properly by Pro Tools|HD Native systems, so for consistent performance it
may be necessary to de-install the second VENUE HDx Option card.
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Known Issues
The following sections document known issues you may encounter when using Pro Tools 11.0 and Pro Tools HD 11.0, along with workarounds if they exist.

General Pro Tools Issues
Error messages are displayed while unzipping the downloaded Pro Tools installer zip file (PTSW-181403)

While unzipping the downloaded Pro Tools installer .zip file, errors are displayed saying that certain files are missing. If you proceed
and run the unzipped installer, then these files will be reported missing. To avoid this issue, move the downloaded .zip file to the root
(top most) directory of a volume first (such as the C: drive), and then unzip.
Clicking on a Pro Tools window that may be visible will not always bring Pro Tools to the foreground, especially if a process
is running in Pro Tools (such as Bounce to Disk)

If Pro Tools is not the foreground application, you can bring it to the foreground by doing one of the following:


Click the Pro Tools icon in the Windows Taskbar.



Press the Start+Tab keys to bring the Pro Tools application to the front.

Pro Tools does not launch (58531)

Pro Tools will not launch if hardware drivers are not installed or if there are no Inputs or Outputs set in the Control Panel for your audio
interface. If Pro Tools does not launch, be sure the drivers for your audio interface were installed before Pro Tools installation. For MAudio and some third-party interfaces, if the drivers are already installed, go to the Control Panel for your audio interface and make sure
either the Analog or S/PDIF Inputs and Outputs are enabled.
The Pro Tools System Usage window displays spikes in CPU usage (PTSW-182238)

On older, slower computers, Pro Tools may display spikes in CPU usage at low Hardware Buffer Size settings (such as 32 or 64 samples). To avoid this issue, increase the Hardware Buffer Size in the Playback Engine dialog (Setup > Playback Engine). You can also
try setting the Default Through Instrument option to None in Pro Tools MIDI preferences (Setup > Preferences > MIDI).
Session templates retain I/O settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools session templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system
on which the template was created. Consequently, new sessions based on a template restores several session properties from the original
system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them.
This also means that if a new blank session is created after using a template, the properties from the template will be used for the new
session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.
Trying to load a session from an unmapped network drive results in the error: “Pro Tools application has stopped working”
(PTSW-125913)

When trying to load a session from an unmapped network drive, the error “Pro Tools Application has stopped working” will occur. To
avoid this problem, be sure to map the network drive to a drive letter, set up the drive as transfer volume, and then open the session.
Synchronizing to external clock with a different sample rate from the session results in the following error: “The current
playback engine does not support a sample rate of 44.1 kHz” (PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may result in
the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” If this happens, correct the sample rate
mismatch and re-select the correct clock rate.
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Windows 7 Systems do not support double-clicking to launch Pro Tools session or installer on external FireWire HFS+ drive
(PTSW-35457)

On Windows 7 systems, if the session or installer is located on an external FireWire HFS+ drive, you cannot double-click on it to launch
the session or installer. To launch a Pro Tools session located on an HFS+ drive, launch Pro Tools first, and then use the Open Session
command in the File menu to open your session. For Pro Tools installation, copy the installer onto an internal drive, and run the installer
from there.
Session Notes dialog frequently appears when opening sessions (PTSW-163563)

The Session Notes dialog frequently appears when opening sessions, but only reports that some paths are unavailable. You should be
able dismiss the dialog and playback the session without incident, but you may want to check your I/O Setup to insure that only valid
paths are configured.
Windows erroneously reports that Pro Tools has stopped responding

Clicking on the splash screen while Pro Tools is launching can result in a Windows error stating that Pro Tools has stopped responding.
Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if you click “Wait for the Program
to Respond.”
Opening sessions created with Pro Tools 7.4 or lower

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0 or higher, all waveform overviews are recalculated. This
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This recalculation
only needs to happen once.
Automation is replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing
session data (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current session start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Maintain Absolute when prompted.
Start+L launches the Switch Admin User prompt instead of nudging cursor to the left (PTSW-17100)

Start+L Key launches the Switch Admin User prompt instead of nudging the cursor to the left. As a workaround, enable Keyboard Focus
(A...Z) and use the L key.
Scrubbing audio is offset by the overall system delay when Automatic Delay Compensation is enabled (PTSW-150138)

With Automation Delay Compensation enabled, when scrubbing audio the output is offset by the overall system delay (displayed in the
Session Setup Window). Large system delays cause a noticeable offset. To avoid this issue, you can disable Automatic Delay Compensation when you want to scrub audio for editing.
DestructivePunch may not behave correctly when using Automatic Delay Compensation (PTSW-157282)

When using the Maximum amount of Delay Compensation, DestructivePunch may not behave correctly. To avoid this issue, do not use
DestructivePunch with system delays over 4,096 samples at 48 kHz, 8,192 samples at 96 kHz, or 16,384 samples at 192 kHz.
Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a different tempo
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one
in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips will play back
correctly.
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Cannot run Reason or Record as ReWire clients if they have not first been launched and set up as a standalone application
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools.
Do the following:
• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.
• Quit Reason or Record.
• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.
Cannot drag and drop media files from the Desktop to Pro Tools (Windows 8 Only) (PTSW-181311)

If UAC is enabled on Windows 8, dragging and dropping media files from the Desktop is disallowed. To avoid this issue, disable UAC.
When importing audio from a network share, “file is unreadable” or other errors occur (PTSW-149570)

When importing an audio file from a network share using the Import Audio dialog or a direct shortcut to the share, Pro Tools may display an error such as “The audio file is unreadable by Pro Tools” or “The mp3 cannot be imported because QuickTime is not installed,”
even though QuickTime is installed on the system. If this occurs, map a drive letter to the network share and use the drive letter in the
Import Audio dialog to navigate to the audio file.
Importing MP3 or MP4 files without QuickTime installed (PTSW-61863)

If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the possibility
that Pro Tools has indexed QuickTime files as “Unknown.” These files will remain as unknown even after QuickTime has been installed. If this occurs, either delete DigiBase Database files and try again, or navigate in the browser to any “Unknown” QT file and select “Update Database for Selected.”
Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the possibility
that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools since QuickTime is
now absent. If this occurs, delete all database files and try again.
Issues with Kensington mouse and drivers

The following may occur when using a Kensington mouse with Pro Tools:
• Alt key sticks when Zooming (61823)
• Stuck Shift Key (62376)
• Stuck Control Key (61830, 62066, 61980, 61988, 62348, and 62559).
To clear stuck keys, press them again. If problems continue, try removing the Kensington drivers.
Error message “Could Not Complete Your Request because the System Cannot Find the File Specified (2)”
(# 50454 and # 50457)

This message can appear while logged into a non-administrative account and doing either of the following:
• Performing destructive AudioSuite processing
• Locking files in the Workspace browser
This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an administrative
account in Windows and change the permissions of the audio file so you have full read and write access to the audio file. If you do not
have administrative access of the computer, then you must either contact the administrator of the computer to resolve this problem, or
use the File > Save Copy In command to create a copy of the session with all of its audio files.
A Workspace search entry of a quotation mark followed by a space results in a search error (PTSW-183098)

In the Pro Tools Workspace, a quotation mark (“) followed by a space is an unsupported text combination for a search query, and will
yield a search error. Re-enter search query without the space.
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More than one Catalog with the same name can be created (PTSW-183432)

From the Workspace, you can create more than one catalog with the same name by right-clicking on any folder and selecting “Create
Catalog from Selection.” To avoid this, create Catalogs by right-clicking “Catalog” and choosing “New Catalog” in the Location pane;
this method prevents duplicate names. If more than one catalog with the same name is created, rename the catalogs.
Groove Templates (43997)

Pro Tools will be unable to retrieve custom Groove Templates that are saved in an incorrect directory. Groove Templates should be
saved only within the “Grooves” folder.
Clip Groups can be dragged to tracks in Playlist view even though Clip Groups are not supported in Playlist view
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally, when
switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip groups
dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist view to ensure proper behavior.
Importing tracks with Import Session Data clears the Undo queue (51775)

It is documented in the Pro Tools Reference Guide that importing tracks through Import Session Data clears the Undo queue. More specifically, the Undo queue gets cleared when Main Playlist Option is set to “Import - Replace existing playlists.” The Undo queue does
not get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”
Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears,
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer
before or during export.
AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in Media
Composer before the AAF is exported.
Intermittent Shuttle Lock commands ignored (47155)

Shuttle Lock commands are occasionally ignored. Click once on the Transport pop-up and the functionality will return.
With the Pro Tools Web browser, links to external sites do not work as expected (PTSW-145325)

In the Pro Tools Web browser, navigating to external sites using links from Avid web pages (such as links to social networks like Facebook and LinkedIn) may not work as expected. For the sake of security, the Pro Tools Web browser is restricted to avid.com pages. If
you want to browse sites other than avid.com, or share avid.com pages with friends, use the Launch Page in External Browser feature
to view the page in your default Web browser and navigate from there.
If you sign into Gobbler after launching Pro Tools, it may be necessary to retry the connection to Gobbler (PTSW-174742,
PTSW-175516)

If you launch and sign into Gobbler after you have already launched Pro Tools, when you try to connect to Gobbler (by choosing the
Setup > Connect to Gobbler or File > Send To > Gobbler commands, or by using the Share With Gobbler option in the Bounce To Disk
or Export Selected dialogs), you may need to click Connect more than once to make the connection to Gobbler. To avoid this issue,
launch and sign into Gobbler before launching Pro Tools.
When Bouncing to Disk or Bouncing to QuickTime, the Bounce hangs if the file name contains an illegal character-such as “:”
or “ü” (PTSW-183327)

To avoid this issue, do not use non-standard characters for bounced file names.
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I/O Setup
I/O Setup files can be saved with illegal characters when Enforce Mac/PC Compatibility option is not enabled (60730)

When importing I/O Setup files (.pio files) from Mac sessions that were not saved with the Enable Mac/PC Compatibility option enabled, files that have illegal characters are not converted successfully—illegal characters do not get replaced with an underscore.
Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes overlapping output paths
or has multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by
routing your sources to a single mapped output bus and assign a Master Fader to that.
Overlapping outputs are not supported for AFL/PFL (PTSW-128167)

While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported for
AFL/PFL monitoring. For example, if paths A 3–4 overlap the main path A 1–2, even though you can select paths A 3–4 for AFL/PFL
monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3–4. You can avoid this problem by using non-overlapping
paths for AFL/PFL monitoring.
I/O Settings Pane appears inactive after editing video track during play (PTSW-183106)

If you edit video during playback, the I/O Setting pane for the Video track appears inactive during playback, preventing you from opening the track’s Output Setting tab. To access I/O settings for the track, stop playback.

File and Disk Management
Auto-saving with external hard drives that have little free space can result in data loss (PTSW-32639)

When recording to hard drives that do not have much free space available and when the Auto-Save preference is turned on, it is possible
to completely fill your record drives, and cause data loss. While this occurrence is rare, it can also result in external drives that will fall
offline and not be able to used on the Windows system. It is recommend that you do not allow your record drives to become completely
full, and that you manually back up your projects on a regular basis.
Pro Tools unable to relink to audio files and fade files that have illegal characters when Enforce Mac/PC Compatibility is not
enabled (PTSW-57355)

A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without the Enable
Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually relink each file by
Unique ID.
Pro Tools 11 sessions that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly
(PTSW-181963)

If you attempt to open a Pro Tools 11 session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will quit unexpectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 gigabytes in
Pro Tools 11 by removing virtual instruments that take up system memory.
Importing interleaved BWF files exported from Pro Tools 10 and higher into Pro Tools 9.0.x (and lower) may cause Pro Tools
to quit unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and higher, and
then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into
lower versions of Pro Tools in another file format (such as AIFF or multi-mono).
Unable to open Mac sessions from Workspace if illegal characters in session name were converted to underscore symbols
(60243)

You will not be able to open a Mac session from the Workspace if the session name contains illegal characters that were converted to
underscores. The workaround is to open the session using the File > Open command.
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Missing files when opening a session that was saved using Save Copy In with Preserve Folder Hierarchy option (74454)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy or create a folder at
the root level of each volume with the session name that contains the Audio Files or Video Files folder. Or, manually relink to the missing files at their current location.
Multiple files with the same name do not relink properly when Save Copy In command is used with Preserve Folder Hierarchy
option (79868)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using
Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been
opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remaining files.
System crash on startup with Mac-formatted FireWire drives (45288)

After installing MacDrive, mount Mac formatted FireWire drives only after Windows has finished starting up. Starting up with FireWire
drives powered on after installing MacDrive causes a system crash.
Disk management when using Mac-formatted drives (45459)

You must disable the MacDrive service in order to convert or re-format an HFS+ FireWire drive to NTFS format.
Loss of sharing information when unmounting drive from Pro Tools Workspace (46273)

Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is unmounted
from within a Pro Tools workspace.
Sluggish performance when a mapped network drive becomes unavailable (44420)

When using Pro Tools, make sure all mapped networks are present and available. If your computer is mapped to a network drive that
becomes unavailable, Pro Tools may become sluggish.
Missing files when opening a session created by a lower version of Pro Tools (37572)

When opening some sessions created by a lower version of Pro Tools, some files may be missing. You should be able to relink these
files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.
After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened.
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files.
“Access Violation” on playback of read-only sessions

Pressing play in a session recently restored from CD-ROM may result in a dialog stating “Access Violation.” This happens if the session
(and its audio files) are marked with the Read-Only flag. If you do not know how to remove the Read-Only flag from your files, please
consult Windows Help.
Unable to create a session when navigating through the Windows 7 Libraries directory (PTSW-133266)

When creating a session in Pro Tools, if you navigate to the location where you want to save the session through the Windows 7 Libraries directory path, you will be unable to create the session. To avoid this problem, navigate to the location where you want to save the
session through another directory path, such as Drive:\Users\User Name\My Documents\... .
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Elastic Audio
When opening legacy sessions (Pro Tools 9 and lower) in Pro Tools 10 and higher, any rendered Elastic Audio clips are
automatically re-rendered (PTSW-139989)

Rendered Elastic Audio clips created in legacy sessions need to be re-rendered for use in Pro Tools 10 and higher. Re-render of these
files occurs automatically when the session is opened in Pro Tools 10 and higher.
Fades on Elastic Audio-enabled tracks may not regenerate when opening sessions created with Pro Tools 10 and higher in
Pro Tools 9.0.x (PTSW-152949)

When saving a copy of a Pro Tools 10 or higher session to v7-v9 and opening the copy in Pro Tools 9.x, some fades might not be regenerated even if you select the option to re-generate fades without searching. If this happens, closing and re-opening the session causes
the missing fades to regenerate.
Real-Time Elastic Audio tracks do not show accurate waveforms (98343)

When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform is a prediction of
what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as rendered by the algorithm
you are using
Maintaining phase coherency with Elastic Audio pitch processing (106002)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing
from the track before switching to the Monophonic or Varispeed algorithm.
Certain audio files cannot be calculated or cleared of Elastic Analysis in Workspace browser (89026)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), but the
Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate Elastic Analysis and Clear Elastic Analysis will be grayed out. In these cases, the file may actually be in a non-supported format. To check the file’s
format, look at the Format column in the Workspace browser. If a file format other than WAV or AIFF is shown (such as QuickTime),
then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still be previewed in tempo, as
well as elasticized once imported into a session.
Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (96151)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the
Monophonic algorithm. If you are using elastic audio with material that contains transient information in it that you would like to keep
from drifting, you should use the Polyphonic or Rhythmic algorithms.
Tempo maps made from Bar|Beat marker generation in Beat Detective cause Clip Groups in Rendered mode to fall offline
(97993)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause clip groups in Rendered mode to fall offline. The
workaround is to make an edit to the offline clip and then toggle the Elastic Audio from rendered to real-time and then back to rendered.
Default Input Gain preference is only for Elastic Audio imported at session tempo (96725)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop
from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.
Displayed timebase is incorrect after importing Elastic Audio tracks (111299)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to manually select the correct timebase for the affected tracks.
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Elastic Audio clips on Playlist lanes are not rendered (111882)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic
Audio processing from Real-Time to Rendered.
Clip Groups containing Elastic Audio are not recognized as Elastic if the Clip Group itself has not had any Elastic functions
applied (# 92770 and # 97107)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the clip
group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not automatically be
Elastic Audio–enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create an Elastic Audio–enabled
track first, then add the clip group to it.
Cannot import Elastic Audio tracks with the Consolidate From Source Media option (96404)

Use Copy from Source Media to import Elastic Audio tracks.
Timing inaccuracy in audio files converted from CAF and MP3 with Preview In Context enabled (111064)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and innerclip asynchronous transients issues). This is inherent with compressed file formats.

MIDI
Sibelius does not launch when using the Send to Sibelius command (PTSW-24193)

When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius command in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem, launch Sibelius manually and create a score document. This will only needs to be done once, after which the Send to Sibelius command should function
properly.
When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using diatonic transposition,
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each key.
Record-enabled MIDI or Instrument tracks play out of time when punching in (98835)

With Delay Compensation enabled, the underlying data on MIDI or Instrument tracks plays out of time when attempting to punch-in to
a record-armed MIDI or Instrument) track.
Unavailable MIDI input paths for MIDI and Instrument tracks are not indicated (PTSW-46839)

The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a session on a
system where the device or path are not actually present.
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Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-ins Read Me.
AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plugin window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error.
This is because a clip group is not treated as audio until it is actually used in a track.
To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:
1

Select the Clip Group to be processed.

2

From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3

Perform AudioSuite processing.

4

From the Clip List menu, select Regroup.

5

When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only
to the selected Clip Group.

Plug-In Find and Relink with file types not supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to file types
that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used in
plug-ins must also be supported by Pro Tools.
Software instrument does not emit sound when inserted on an Instrument track or Auxiliary Input (THP-157)

Some software instruments will not emit sounds and will not play. If this occurs, manually assign a hardware input to the Instrument
track or Auxiliary Input, and/or manually assign a MIDI output to the Instrument.
MIDI outputs to some software synthesizer plug-ins are italicized in cross-platform sessions (54173)

With some software synthesizers, MIDI output ports show up italicized when opening a session on a different computer platform than
the session was created on until you re-assign the outputs.
Expired demo plug-ins

Using a demo plug-in whose trial period has ended may result in an “Illegal Instruction Attempted” error within Pro Tools. Removing
the expired demo plug-ins from your Plug-ins folder will rectify the situation.

Pro Tools|HDX Systems
Pro Tools does not play back when an invalid sync source is selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.
In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for Avid HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate
to the first physical slot in the machine. If you have an Avid HDX card that is having problems, match the Serial Number ID on the back
of the card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.
Audio stops in certain circumstances with multi-card HDX systems (PTSW-158701 and PTSW-157600)

Signal routing issues are known to occur with HDX systems on HP Z800 Workstations. To resolve these issues, run HP Performance
Advisor software after installing Pro Tools, and load the Avid optimized settings.
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Corrupted audio when bus recording (signal inverts every 8 samples) (PTSW-158063)

HP Z800 workstations can drop samples while recording when an HDX card is present in PCIe Slot #3 (connected to the Southbridge).
This recording problem is resolved by updating the HP Z800 to the latest BIOS (3.54). Use the HP Performance advisor to update your
machine before or after installing your Avid HDX card(s).

Pro Tools|HD Native Systems
Audible pops and clicks when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid
any possible damage to your speakers.

Control Surfaces
Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem,
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.
Used HW output path indication (101095)

In Assign Matrix, Insert mode the used HW output path will not have amber background indicating that it's already assigned after
switching to a different insert on the same track.
Color indication on plug-in controls in Learn mode (102710)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the Plugin window will be red if the track is in one of auto write modes. This conflicts with red color indication on the Plug-in control, which
is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.
Send/Pan mode on D-Command for Sends F–J (82871)

In Pro Tools 7.3 and higher, if you save a session on D-Command which is in Send/Pan mode for Sends F-J, the session will open in
previous versions of Pro Tools with the channel fader controlling that Send level, as if in Flip mode. To avoid this, open the same session
in Pro Tools 7.4, take the session out of Send/Pan mode, and re-save the session.
SignalTools meter ballistics on control surfaces (74340)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.
Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter instead of in the Expander/Gate meter in
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Expander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main
Unit).
Pro Tools transport must be stopped when recalibrating ICON faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders.
exit Utility mode.
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The Edit and Mix windows do not follow banking on EUCON control surfaces (PTSW-133466)

When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in Pro Tools
(Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have
to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON controller if they are off screen.

Video
Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop
frames. To improve results with QuickTime playback, try any of the following:
• Disable Continuous Scrolling.
• Close unnecessary UI windows.
• Try using the DNxHD codec.
• A second Pro Tools, Media Composer, or Symphony DX Video Satellite option offers guaranteed performance for Avid video playback with a primary Pro Tools|HDX or Pro Tools|HD Native system.
Video clip does not playback and shows only black when placed 12 hours or more from session start (crossing the “midnight”
threshold) (PTSW-184316)

Video clips show only black when placed 12 hours or more from session start, which also crosses the “midnight” threshold. Video clips
placed after the timecode position 00:00:00:00, in sessions with starting timecode values greater than 00:00:00:00 may result in only
black displaying to the video outputs at those locations. Make sure that you do not place video clips past the midnight threshold.
No checkmark next to DNxHD video clips in the Clips List (UME-820)

DNxHD files that contain an Alpha channel will not run in an optimized performance mode. Because of this, there will be no check mark
next to these files in the Clips List or on video clips in the Edit window when choosing to view Processing State. For optimized playback
of DNxHD QuickTime, transcode the file without an Alpha channel using the Pro Tools Bounce to QuickTime command or using a
third-party application.
Unsupported QuickTime video formats (72933, 72956, 72958, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies.
Attempting to import these will generate errors or will fail to import.
QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more
than one CODEC are not officially supported for import into Pro Tools.
Closing the QuickTime window during session playback may result in –9092 errors that stop playback (PTSW-162592)

To avoid this issue, try increasing the number of CPU Cores available for Pro Tools processing and/or raise the H/W Buffer Size in the
Pro Tools Playback Engine dialog.
Pro Tools UI may slow down with densely-edited QuickTime movie track (77720)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes more
and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins to decline, use the
Bounce to QuickTime Video command, then import the bounced movie.
Playback of PhotoJPEG-encoded video experiences dropped frames or stuttering (PTSW-183056)

PhotoJPEG is not a preferred CODEC for video playback in Pro Tools. It you experience performance issues with this CODEC, please
transcode to a preferred Avid CODEC, such as DNxHD or DV25. This can be done by bouncing the file to QuickTime from within
Pro Tools and choosing the “Advanced Settings” in the bounce window.
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Non-standard sized video clips may open at unintended Video Project Rates (PTSW-180726)

Non-standard sized video clips may open at unintended Video Project Rates when imported into your Pro Tools session. To avoid this
issue, import them while pressing the Command key (Mac) or the Control key (Windows) to be able to choose any Video Project Type.
“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our primary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue.
MPEG-1 and MPEG-2 video freezes at edit points (79182)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie
with a 3rd party application may also fix the problem.
3G2 file extension is not supported for video import (PTSW-178015)

Pro Tools 11 provides support for the .3GP file type extension for video import. These are video files often created on mobile phones.
The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as unavailable
for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files remain unavailable for import after changing their extension, they will need to be converted to an explicitly supported format such as DNxHD or
AppleProRes for use in Pro Tools.
Video track’s video format doesn't match session's video format when switching between NTSC and PAL (77328)

In some cases when switching from NTSC to PAL or from PAL to NTSC, a newly created Avid video track will display the wrong video
format. Trying to record to this track will give the error, “Session frame rate must be compatible with either PAL or NTSC.” Toggling
the Video Format selector from NTSC to PAL or from PAL to NTSC in the Session Setup window will clear this problem.
Audio and video will not stay in sync when using ASIO4ALL (PTSW-179261)

When ASIO4ALL is selected as the Pro Tools Playback Engine, video may drift out of sync and even drop frames. To avoid this, use
a supported Avid audio interface.
Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”
Project Type does not change to reflect the new project rate after a pull factor is applied to video (PTSW-179896)

When video is pulled, the Project Type selector does not change to match the resulting project rate. This is because the fundamental rate
of the project does not change. The Avid Video Engine continues to reference the fundamental rate while applying the selected pull factor.
Delay in playback start with video .1% pull up from 23.976 fps (UME-649)

When doing a video pull up of .1% from 23.976 fps, you may experience a delay of up to 3 seconds after starting the transport. To avoid
this issue, set the session start to 00:00:00:00.
Video pull settings menu lists spurious information (PTSW-181178)

The Video Pull Settings menu lists both a pull factor (in percent) and an implied video format transition (bracketed text), which is an
artifact of the Audio Pull Settings menu. The pull factors are correct and the bracketed text can be ignored.
Media Composer 6.5 Video Satellite not seen by Pro Tools (PTSW-183505)

Media Composer 6.5 does not appear as a Video Satellite when used with Pro Tools 11. A Media Composer 6.5.x patch is required to
run Media Composer with Pro Tools 11 in this configuration. Visit www.avid.com for Media Composer 6.5 updates.
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Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.
Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.
Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.
External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.

Third-Party Video Peripherals
The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.
In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with
Pro Tools. (THPV-2)



Some video peripherals will scramble output when Pro Tools video thumbnails are drawing. To avoid this, set the Video track to
Blocks view. (THPV-8)





With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup >

Video Sync Offset and enter a 1 frame offset. (THPV-9)
 With some video peripherals, desktop video will be offset by 1–2 frames when the video peripheral is active. This can be fixed by
disabling the hardware from Options > Disable Video Hardware, or alternatively this can be compensated for using Setup > Video Sync
Offset. (THPV-10)

Some video peripherals will lose AV Sync when playback is attempted from a 9-pin controller when linked with other Pro Tools or
Media Composer Satellites. To avoid this issue, attach the 9-pin controller to a Pro Tools Satellite that does not have a third-party video
peripheral attached. (THPV-11)





Some video peripherals will not update the video display to the correct location when the Pro Tools transport stops. (THPV-12)

 With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral
is disabled. (THPV-13)

Synchronization and Machine Control
Recording with serial timecode (64636)

Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked before
it actually is. This could cause a synchronization offset when Pro Tools locked to serial timecode generated from a DA-98. Pro Tools
will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in the “Delay before locking
to Timecode” preference.
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The “Machine Cues Intelligently” preference should not be used with non-linear decks (46200)

Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked when using
non-linear playback devices.

Satellite Link
The Administrator may appear grayed out and unavailable on Administrator system in the Satellite page in the Peripherals
dialog (PTSW-181483)

The Administrator system may appear to be unavailable in the list of available Satellites as displayed by the Administrator’s Satellite
system in the Satellite page in the Peripherals dialog. Should this happen, toggle the Satellite Mode to Satellite from Administrator and
back to reset it.

Video Satellite
Linking Video Satellite and Satellite Link (Item # 109199)

When trying to link to a the Media Composer system in a Satellite Link configuration with Video Satellite configuration, you cannot link
from any Pro Tools Satellite system. You will need to link from the Media Composer or the Pro Tools administrator system.
Video Satellite Doesn't Support Loop Playback when Selection is Less than One Second (Item # 93743)

When looping playback with Video Satellite, if the selection is less than one second, playback may stop after a few loops or Media Composer may post a “Pro Tools cannot currently play” dialog. The workaround is to make a selection that is 1 second or longer.
Pro Tools and Media Composer Video Satellite Quit Unexpectedly when Disconnecting an Additional Pro Tools System During
Playback (Item # 110601 and # UDevC00115566)

When multiple Pro Tools systems are connected via Satellite Link in conjunction with a Video Satellite, always stop playback before
disconnecting any of the systems.
“Pro Tools Cannot Currently Play” Error (Item # UDevC00116083)

In a Video Satellite configuration, when the system is sitting idle, Media Composer may post the dialog, “Pro Tools cannot currently
play, is online with Machine Control, or is in Transport = Remote Mode. Please resolve the issue with the Pro Tools system and try
again.” To avoid this problem, link the Video Satellite from the Pro Tools Administrator system rather than from Media Composer.
Audio Energy Plot Disappears in Media Composer when Video Satellite Playback is Stopped (Item # UDevC00115392)

If the Audio Energy Plot disappears in Media Composer when Video Satellite playback is stopped, minimize Media Composer to force
a redraw.
An Exception Error Occurs when Launching Media Composer (Item # UDevC00115632)

An exception error occurs when launching Media Composer or enabling Video Satellite mode in Media Composer if there is no valid
network card in the system, or if the network card is disabled. If this happens, quit Media Composer and enable or install a valid network
card. Video Satellite requires a network connection. If you are not using Video Satellite, disable Video Satellite mode in Media Composer’s Video Satellite setting.
Clips on Satellite Track Don’t Move when Changing the Session Start Time in Pro Tools (Item # 105387)

When changing session start time in Pro Tools, clips on a satellite track do not move when “Maintain Time Code” is selected, or when
undoing a previous session start time change. You will need to move the clips on the Satellite track manually.
23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.
As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.
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Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be
offset by as much as one frame.
As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.
29.97 Digital Cut Output Format in 23.976 and 24p Projects Causes Media Composer to Play Faster Than Pro Tools (Item #
UDevC00082004)

When you are working with a 23.976 or 24p project in a video satellite, setting the Digital Cut Output Format to 29.97 causes
Media Composer to play 25% faster than Pro Tools. This setting is intended for video-only transfers.
As a workaround, unlink Media Composer from Pro Tools during the digital cut. Note that appropriate Output Format setting for broadcast masters is 23.976.
Playing a Complex HD sequence with SD Down-Convert Enabled Causes Synchronization Error (Item # UDevC00091109)

If you down-convert a complex HD sequence in real-time while playing back a video satellite sequence in DNA mode, Media Composer
may abort play and post the following message: “Synchronization error. Aborting play.”
As a workaround, do one of the following:
• Switch the project back to HD format and use 1394 mode to play back.
• Create a video mixdown of the sequence.
• Transcode the media to SD before playing back.
Audio and Video May Drift Out of Sync In Satellite Mode in Certain Conditions (Items # UDevC00090064, UDevC00090078,
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any
of the following conditions:
• When monitoring video in 1394 mode via full screen playback. This is due to the difference between the monitor's refresh rate and
the video reference rate.
• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)
• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times without stopping.
Media Composer Export Including Copied or Consolidated Media to a Location Other than the Pro Tools Session Folder
Prevents Pro Tools from Automatically Locating Media Files (Item # UDevC00056745)

When you export an AAF or OMF sequence from a video satellite using the Copy All Media or Consolidate Media option, make sure
to save media files to the root level of the Pro Tools session folder. This ensures automatic relinking of media when you import the AAF
or OMF sequence into Pro Tools. Also, if you export a sequence from the video satellite with the audio storage mounted on the satellite
system, save the AAF or OMF to the root level of the Pro Tools session folder, and choose Folder, then choose Use Same Folder as
AAF/OMF file when exporting the sequence.
If the Avid MediaFiles or OMFI MediaFiles folder is located somewhere other than the root folder of the destination Pro Tools session,
Pro Tools cannot automatically relink to the media. If you did not export the sequence to the Pro Tools session folder as described
above, you can do either of the following as a workaround:
• Re-export the AAF or OMF sequence from the video satellite as described above.
• Use Pro Tools to manually search for the media by Name and Unique ID.
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Avid Interplay
Unable connect to Interplay server by entering its IP address (PTSW-173106)

With Interplay Access 2.7, when importing a sequence from Avid Interplay into Pro Tools, if you try to connect to an Interplay server
by entering its IP address, an error message is displayed and the connection fails. To connect to the Interplay server, enter its server name
instead of its IP Address.

General Localization
Relinking using MacDrive Version 6 to open sessions from other platform (65528)

MacDrive version 6 strips the extensions off of files in “Normal Use” mode - you need to use “Backup/File Transfer” mode to avoid
having the extensions stripped off. However, “Backup/File Transfer” doesn't work well with multibyte characters, as “International
Use” does. “International Use” also strips the extensions, so you either have to not use multibyte characters, or have the trouble with
stripping extensions. These used to be separate options in MacDrive 5, but in 6 you can't get one without the other. To get around the
stripping extensions, you can do a Relink by ID only, and have it search through all the files to match them up - this is the only workaround.
AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570,
PTSW-33826)

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not import
correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect all
options except “Find by file ID.” Clip names may appear garbled.
Inconsistent MIDI performance on Dutch OS with English Pro Tools (59608)

When running the English version of Pro Tools on Dutch OS, MIDI output can slow down with extended use.

Known Issues with Audio Interfaces
Avid DigiTest firmware updates appear to freeze when DigiTest is not the front-most application (PTSW-138994)

When clicking outside the Avid DigiTest window, the Graphical User Interface (GUI) may appear to freeze. However, the firmware update will complete successfully. If you encounter this issue, please wait for the firmware upgrade to finish. You will know that the firmware update completed successfully when the GUI becomes responsive again.
When switching audio interfaces, some devices may fail to load proper drivers with the Found New Hardware wizard
(PTSW-28118)

When switching audio interfaces, the Found New Hardware Wizard will sometimes properly identify the device, but then fail to install
the needed drivers. If this happens, with the new device connected, go to Add or Remove Programs in the Windows Control Panel,
choose the audio interface, select Change, and run a “Repair” install. The driver installation should complete with the Found New Hardware Wizard.
Changing sample rates during a session can cause session to play at a faster or slower speed (56697)

Changing Sample Rate during a session from the Control Panel for your audio interface can cause the audio to playback at the incorrect
speed. Consequently, the data could be unrecoverable afterwards. Before creating a session, set the Sample Rate in the Control Panel
for your audio interface and do not make changes thereafter.
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HD OMNI
Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital
source and HD OMNI are matched correctly.
HD OMNI front panel SETUP menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.
Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases.
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.
No sound on output after Hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.
Loss of monitor path with launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.
Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding monitor path
in the Monitor page of the Hardware Setup, and re-assigning the outputs from “None” to physical outputs in the Main page of
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None”
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
Changing monitor path output assignments in the Hardware Setup does not update the output paths in the Output page of the
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
When creating new sessions, using the I/O Settings selector can result in unexpected output assignments if HD OMNI has an
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the
I/O Setup (or click Default).
I/O Setup Bus page erroneously adds Monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments
accordingly.
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Avid Audio Interfaces with ASIO Third Party Client Software
When adjusting the Hardware Buffer Size in a third-party audio application (such as Reason), the Avid Hardware ASIO driver
may quit unexpectedly (PTSW-162469, PTSW-154719)

It is possible to select an unsupported hardware buffer size for some Avid audio interfaces when using third-party ASIO client software
(such as Reason or Cubase). To avoid this issue, use the Avid hardware driver control panel to change the hardware buffer size.

003 Series Interfaces
Windows Standby Mode and the 003 interfaces (47054)

Always disconnect 003 interfaces before putting Windows into Standby mode.
Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on the scribble
strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on
003 and then re-enter Plug-in Edit mode to correct this.

Mbox 2 Pro
The Mbox 2 Pro driver version 11 does not work with Pro Tools 10.x (PTSW-182163)

The Mbox 2 Pro driver version 11.0.0 will not work with Pro Tools 10 or lower. Use Mbox 2 Pro driver version 9.0.2 with Pro Tools
10 or lower.
External clock not supported at higher sample rates with Mbox 2 Pro (PTSW-59087, PTSW-59095, PTSW-59097, PTSW-58879)

Although Mbox 2 Pro supports sample rates of up to 96 kHz, its external clock sources (S/PDIF and Word Clock) are only supported
in 44.1 and 48 kHz sample rate sessions.
Transport disabled after changing sample rate of external sync source (PTSW-58879)

If the Pro Tools Clock Source is set to S/PDIF or Word Clock, and the sample rate of your external source changes, sync will be lost
and you may not be able to play back when sync resumes due to –9092 errors. This is most likely to appear if the sample rate of your
external source changes while the Pro Tools transport is moving.
To avoid this condition, make sure your external source is always set to the same sample rate as Mbox 2 Pro, especially during playback.
To correct this condition should it occur, do the following:
1

In Pro Tools, choose Setup > Hardware and set the Clock Source to Internal

2

Make sure your external sync source is properly connected and at the same sample rate as Mbox 2 Pro.

3

In Pro Tools, choose Setup > Hardware and set the Clock Source back to the desired source (S/PDIF, Word Clock, or Internal).

Some machines may encounter “Audio Play Startup Deadline was Missed” errors at HW Buffer size 64 or if “Minimize
Additional I/O Latency” is enabled (PTSW-28238)

On some machines, and with Mbox 2 Pro, enabling “Ignore Errors During Playback/Record” and selecting “Minimize Additional I/O
Latency” in the Playback Engine dialog, or running at a HW Buffer size of 64 samples may cause you to encounter “Audio Play Startup
Deadline was Missed” errors when starting the transport. This may be compounded if the Mbox 2 Pro is synced to an external clock. If
you encounter this, set your clock source to Internal and, if needed, deselect “Minimize Additional I/O Latency” and set the HW Buffer
size to 128 or higher.
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Mbox 2
MBox 2 can have lower track counts on Windows 7 on the HP 8600

Depending on your CPU, you may need to disable your computer’s network cards in order to achieve the maximum possible track
counts.
Audio pop through Mbox 2 outputs when enabling/disabling AC-3 Mode (63293)

In the Mbox 2 Control Panel, checking or unchecking the option for AC-3 produces an audio pop through the analog output.
Mbox 2 does not support sample rates of 49 kHz or Above (63141)

Mbox 2 does not support sample rates of 49 kHz or above due to the bandwidth limitations of USB 1.1 and the USB Controller. This
is only an issue when syncing to an external S/PDIF clock that is pulled up 2% or more above a nominal 48 kHz sample rate.

M-Audio Interfaces
ASIO4All conflicts with M-Audio peripherals (PTSW-130316)

Pro Tools may quit unexpectedly and other unexpected behavior may occur if ASIO4All is installed on a system with M-Audio peripherals connected. If this occurs, it is recommended that you either disconnect the M-Audio peripheral when using the ASIO4All driver
or uninstall ASIO4All.
Opening the FireWire 1814 Control Panel causes computer to crash or the screen to turn blue (57675)

The FW1814 Control Panel does not support AGP video Hardware Acceleration and Write Combining enabled. Having these items enabled can cause the computer to crash. Go to Display Properties > Settings > Advance > Troubleshoot, and set Hardware Acceleration
to None, then disable “Enable write combining.” When the settings have been updated, you can open the FireWire 1814 Control Panel
without causing a crash.
When external sync changes sample rates, FireWire 1814 driver can lose current sample rate (58741)

On FireWire 1814 interfaces, when the external sync changes its sample rate, the M-Audio hardware driver can sometimes get confused
about the current sample rate. For instance, the dialogue “The current playback engine does not support a sample rate of 44.1kHz” is
posted when opening 48kHz session after switching Sample Rate from 48kHz to 44.1kHz and back to 48kHz on an external device with
S/PDIF outs.” The workaround is to get the sample rate of the external device stabilized to what you want, exit Pro Tools (to release the
M-Audio driver completely), then restart Pro Tools and open your session.
M-Audio Delta Driver Control Panel defaults to no audio output because the output faders are set to –Infinity (minus infinity)
(60160)

The Delta driver Control Panel defaults to no output fader gain because the output faders are set to –Infinity (minus infinity). To hear
audio, you need to change the gain in the Control Panel.
M-Audio FireWire devices can fully reset or hang when device is locked to external device via SPDIF and sample rate is changed
to a higher sample rate (59481)

If an M-Audio FireWire device is locked to an external device via SPDIF, changing the sample rate of the external from 44.1k/48k to
88.2k/96k while Pro Tools is open, will cause the FireWire device to perform a full reset causing Pro Tools to become non-responsive.
The workaround is to make sample rate changes prior to launching Pro Tools.
M-Audio hardware compatibility with Sony VAIO machine (58084)

There are known compatibility issues with installing M-Audio hardware drivers on some types of Sony VAIO computers. Please refer
to the M-Audio customer support site for the latest updates on system compatibility.
Compatibility with wireless network card and M-Audio hardware (58435)

Using a wireless networking card with Pro Tools can cause noise to be output from your hardware. To avoid this, you should disable
your wireless networking card.
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Pro Tools loads until “DAE Loaded” message, but never launches (56701)

With M-Audio devices, disabling all of the Inputs and Outputs in the M-Audio Control Panel can cause Pro Tools to not launch. Go to
the M-Audio Control Panel and make sure the S/PDIF or Analog Inputs and Outputs are enabled before launching Pro Tools.
Pro Tools application freezes after disconnecting M-Audio device (58951 and 95255)

If an M-Audio device is disconnected while Pro Tools is running, Pro Tools will let you save the session, but will freeze during quit. In
general, do not disconnect M-Audio devices while Pro Tools is running. If for some reason the device gets disconnected, the current session can be saved normally. However, Pro Tools may need to be forced to quit afterwards by using Alt+F4 or Control+Alt+Delete. After
a forced shut down, Pro Tools can be re-launched as long as the M-Audio device has been reconnected. The host computer does not need
to be rebooted in this case.

ASIO Audio Interfaces
Pops and clicks can occur when using third-party ASIO audio interfaces with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try increasing the Hardware Buffer size for the device to avoid this problem.
Pro Tools cannot locate installed ASIO hardware on launch (PTSW-132125)

There are known issues with some third-party ASIO devices not being recognized by Pro Tools 10.x. For a list of third-party hardware
compatibility issues, please visit www.avid.com/compatibility.
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Error Messages
Error –6031 during playback (32637)

If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the session,
quit and re-launch Pro Tools, then re-open the session before resuming playback.
DAE Error –9132

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks to the
appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.
Error –5000 (Unknown Error) when launching Pro Tools (36130)

On a system with multiple partitions, if different InterLok PACE versions are installed on different partitions, Pro Tools will report an
“Unknown –5000 error” on launch. To avoid this problem, install the same PACE components on all partitions on your system.
Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and
relaunch Pro Tools, open the Playback engine dialog, and change the Number of Voices to a setting that uses fewer per DSP.
Error –6074 when toggling all plug-ins between Active and Inactive mode during playback (55049)

In large sessions, deactivating and reactivating all the plug-ins simultaneously can cause Pro Tools to post the following error: “The engine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate and deactivate
plug-ins in smaller groups.
Error –9073 when recording to a FireWire drive and the 2 GB file limit is reached (42611)

When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Recording has
been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem with the hard drive.
Error –9073 other than when recording to a FireWire drive and the 2 GB file limit is reached

If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (www.avid.com/us/support).
Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 errors during playback with Native plug-ins or dense automation.
Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 errors during playback with dense automation.
Error –9735

When Pro Tools reaches the end of its time limit in the Timeline, or if Pro Tools has been in continuous play for longer than the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the session sample rate. For
more information, see the Pro Tools Reference Guide.

Pro Tools 11.0.2 on Windows 7 and Windows 8, and Pro Tools HD 11.0.2 on Windows 7 — 9/11/13

25

